EPSON Stylus Photo 825

Printer Parts

Using the Control Panel

Paper support

Printer cover

When printing in stand-alone mode (without a computer),
you can use the control panel to select print settings:
Card eject
button

Settings

Menus

Memory card
slot
Output tray
(extended)

Left edge guide
(adjustable)

Use arrow
buttons to
select menu
settings

Preview monitor slot
Paper thickness lever

Press to
cancel
settings or
print job

Press to start printing

Option and Accessories
Options
Preview monitor port
Option

Roll paper holders

USB port

Ink cartridge holder

Processing light
Error light

Part number

Preview monitor (black)

C12C860005

Preview monitor (gray)

C11C860005

PCMCIA (CompactFlashTM)
card adapter

2034142

Multimedia (4-in-1) card
adapter

SDMA

The Dazzle® 4 in 1 adapter, which is commercially available,
has also been tested and found to work with this printer.

Ink Cartridges
Cartridge

Part number

Black

T007201

Color

T008201

Ink cartridge replacement button
For available EPSON® paper types, see page 3.

Roll paper button
Maintenance button
Power button
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EPSON Stylus Photo 825
Environmental

Printer Specifications

Temperature

Printing
Nozzle
configuration

288 nozzles (48 each: black, cyan,
magenta, yellow, light cyan, light
magenta)

Print direction

Bidirectional with logic seeking

Control code

ESC/P Raster, EPSON Remote command

Input buffer

32KB

Operation

50 to 95 °F (10 to 35 °C)

Storage*

−4 to 104 °F (−20 to 40 °C)
1 month at 104 °F (40 °C)

Transit*

–4 to 140 °F (–20 to 60 °C)
120 hours at 140 °F (60 °C)

Humidity (without condensation)
Operation

20 to 80% RH

Storage*

5 to 85% RH

*Stored in shipping container

Mechanical
Paper capacity

100 sheets of 17 lb (64 g/m2) paper

Dimensions
Storage

Width: 18.4 inches (467 mm)
Depth: 10.1 inches (256 mm)
Height: 8.4 inches (212 mm)

Printing

Width: 19.4 inches (492 mm)
Depth: 21.5 inches (547 mm)
Height: 11.9 inches (302 mm)

Weight

Safety Approvals
Safety standards

UL 1950, CSA 22.2 No. 950

EMI

FCC part 15 subpart B class B
CSA C108.8 Class B

Ink Cartridges

11.6 lb (5.25 kg) without ink cartridges

Specification

Black ink cartridge

Color ink cartridge

Color(s)

Black

Cyan, Magenta, Yellow,
Light Cyan, Light Magenta

Ink yield*

540 pages; A4, 3.5%
(ISO/IEC letter pattern),
text at 360 dpi

220 pages (A4, 360 dpi,
5% coverage each color)

Cartridge life

2 years from production date (if unopened)
(within 6 months after opening package, at 77 °F
[25 °C])

Storage
temperature

−4 to 104 °F (−20 to 40 °C)
1 month at 104 °F (40 °C)

Transit
temperature

−22 to 140 °F (−30 to 60 °C)
1 month at 104 °F (40 °C)
120 hours at 140 °F (60 °C)

Electrical
Specification

120 V Model

Input voltage *

99 to 132 V

Rated frequency

198 to 264 V
50 to 60 Hz

Input frequency
Rated current

220−240 V Model

49.5 to 60.5 Hz
0.45 A

0.25 A

Power consumption Approx. 15 W (ISO10561 Letter Pattern)
Approx. 3.5 W in standby mode

Freezing
3.2 °F (−16 °C)
temperature**

* Check the label on the back of the printer for your printer’s
voltage.

Dimensions

0.8 × 2.4 × 1.5 inches
(W × D × H)
20.1 × 60 × 38.5 mm
(W × D × H)

−0.4 °F (−18 °C)
1.9 × 2.4 × 1.5 inches
(W × D × H)
49.1 × 60 × 38.5 mm
(W × D × H)

* The figure given is based on continuous printing after ink
replacement. The actual print capacity may vary, depending on
how often you turn on the printer and how often you clean the
print head.
** Ink thaws and is usable after approximately 3 hours at
77 °F (25 °C).
To ensure good results, use genuine EPSON cartridges
and do not refill them. Other products may cause
damage to your printer not covered by EPSON’s
warranties.
Don’t use an ink cartridge that’s older than the expiration
date on the package.
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EPSON Papers

Selecting the Media or Paper Type
Setting

When printing without a computer, choose one of the
following EPSON papers. You can also use plain paper.

When printing without a computer (in stand-alone mode),
select the following Paper Type settings from the printer’s
control panel:

When printing from a computer, additional paper types are
available. See Printer Basics for details.

For plain paper. Recommended for index or test
prints.

Available papers when printing without a computer
Paper name

Size

EPSON Glossy Photo Paper

Borderless 4 x 6 inches,
non-perforated
Letter (8.5 x 11 inches)

EPSON Premium Glossy
Photo Paper

EPSON Matte Paper
Heavyweight
EPSON Premium
Semigloss Photo Paper
EPSON Photo Stickers® Kit
(CD-ROM/paper)
EPSON Photo Stickers
(refill)
EPSON Photo Quality Ink
Jet Paper
EPSON ColorLife Photo
Paper

For EPSON Premium Glossy, Premium Semigloss,
or ColorLife Photo Paper.

Part
number

Letter (8.5 x 11 inches)
Borderless 4 x 6 inches
Borderless 5 x 7 inches
Borderless 8 x 10 inches
Roll (4 inches x 26 feet)
Borderless 8 x 10 inches
Letter (8.5 x 11 inches)
Letter (8.5 x 11 inches)
Roll (4 inches x 26 feet)
A6 (4.1 x 5.8 inches)
A6 (4.1 x 5.8 inches)

For EPSON Matte Paper Heavyweight.

S041458
S041141
S041649
S041272
S041271
S041286
S041667
S041682
S041464
S041465
S041302
S041467
S041257
S041331
S041329
S041144KIT
S041144

You can further adjust the setting if you’re printing on one of
these papers:
❏ For EPSON Photo Paper or Glossy Photo Paper, press the
button and hold it until PP flashes on the Select Photo
menu.
❏ For EPSON Photo Quality Ink Jet Paper, press the
button and hold it until SF (SuperFine) flashes on the
Select Photo menu.
When printing from your computer, select from the following
Type settings (Windows) or Media Type settings (Macintosh)
in the driver software:
Media Type settings supported by printer driver software
Paper

Setting
Plain paper
360 dpi Ink Jet Paper

Letter (8.5 x 11 inches)

S041062

Plain paper sheets or envelopes
EPSON Premium Bright White Paper

Letter (8.5 x 11 inches)

S041500

EPSON Iron-On Transfer Paper

EPSON Photo Quality Ink Jet Paper
Photo Quality Ink Jet Paper
EPSON Photo Quality Ink Jet Cards
EPSON Photo Quality Self Adhesive Sheets

Borderless Papers
BorderFreeTM printing is available for a variety of paper types
and sizes, whether you’re printing from your computer or in
stand-alone mode.
Borderfree-compatible papers
Paper name

4×6

5×7

8 × 10

4-inch
roll

Glossy Photo Paper

✓

—

—

—

Premium Glossy Photo Paper

✓

✓

✓

✓

Premium Semigloss Photo Paper

—

—

—

✓

Premium Luster Photo Paper

—

—

—

—

Matte Paper Heavyweight

—

—

✓

—
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EPSON Matte Paper Heavyweight
EPSON Double-Sided Matte Paper

Matte Paper Heavyweight

EPSON Photo Paper

Photo Paper

EPSON Glossy Photo Paper
EPSON All PUrpose Glossy Paper
EPSON Photo Quality Glossy Paper
EPSON Glossy Photo Greeting Cards
EPSON Panoramic Glossy Photo Paper

Glossy Photo Paper

EPSON Premium Glossy Photo Paper
EPSON Premium Luster Photo Paper
EPSON Semigloss Photo Paper

Premium Glossy Photo
Paper

EPSON Photo Stickers
EPSON Photo Quality Glossy Film

Photo Quality Glossy Film

EPSON Ink Jet Transparencies

Ink Jet Transparencies

EPSON ColorLife Photo Paper

ColorLife Photo Paper
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EPSON Stylus Photo 825
❏ Do not load paper higher than the arrow mark on the left
edge guide. (Some papers should be loaded just one sheet at
a time.)

Media Loading Guidelines
❏ See page 3 for EPSON papers that can be used with this
printer.
❏ Except for envelopes, load paper short edge first, even when
printing landscape-oriented pictures. Load envelopes flap
edge first with the flap side down.
❏ Always handle sheets by the edges, and don’t touch the
printable surface.
❏ Be sure to load the printable (whiter) side of the media face
up in the sheet feeder.

❏ In addition to the Media Type (or Paper Type) setting,
remember to select the correct Paper Size for your media.
❏ If the special media has protective sheets between each sheet
of media, be sure to remove the protective sheets before
printing.
❏ Some special media have a cut corner that you need to
position in the upper right when loading.

Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time, EPSON cannot attest to the
quality of any non-EPSON brand or type of paper. Always test samples of paper stock before purchasing large quantities or printing large
jobs.
Poor quality paper may reduce print quality and cause paper jams and other problems. If you encounter problems, switch to a higher
grade of paper.
Do not load curled or folded paper.
Use papers under these conditions:
Temperature: 59 to 77 °F (15 to 25 °C)
Humidity:
40 to 60% RH
Store printouts on Photo Quality Glossy Film and Self Adhesive Sheets under these conditions:
Temperature: 59 to 86 °F (15 to 30 °C)
Humidity:
20 to 60% RH

Printable area

A:

A
B-L

A

B-R

B-L

B-R
C

envelopes
C

single sheets/index cards

The minimum top margin is 0.12 inch (3.0 mm).
When loading multiple sheets of EPSON Photo Quality Glossy
Film, the minimum top margin is 1.2 inches (30.0 mm).
B-L: The minimum left margin is 0.12 inch (3.0 mm).
B-R: The minimum right margin is 0.12 inch (3.0 mm) for all papers
except DL envelopes (0.28 inch [7.0 mm]) and No. 10 envelopes
(1.10 inches [28.0 mm]).
C: The minimum bottom margin is 0.55 inch (14.0 mm).
*
You can extend the minimum bottom margin to 0.12 inch (3.0 mm)
by selecting Maximum as the Printable Area setting. However,
print quality may decline in the expanded area.
** When printing with the No Margins setting, print quality may
decline in the top and bottom areas of the printout and some of
the image will be cropped.

** no margins
(4 × 6, 5 × 7, 8 × 10,
and letter-size only)
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Printing Without a Computer
The Stylus Photo 825 lets you print photos without using a
computer by inserting a digital camera’s memory card into the
printer.

Removing Memory Cards
When you’re finished printing from a memory card, make
sure the Processing light is not flashing before you remove the
card. Then press the button to eject the card and pull it out of
the slot.
Do not eject a card while the Processing light is flashing, or
you may lose data on the card.

Inserting a Memory Card
The printer supports the following types of memory cards:
CompactFlash™ Type I and II, SmartMedia,™ Sony Memory
Stick,® and IBM® Microdrive.™

If your computer is connected and turned on, you should also
take these steps:

A PCMCIA adapter (PC card adapter) for CompactFlash
Type I memory cards and a multimedia (4-in-1) adapter are
included with the printer; these let you use the types of cards
listed above. If your camera uses a different type of card, you can
purchase the appropriate adapter.

❏ On a Macintosh, select the memory card icon on your
desktop and drag it to the Trash. If you remove the card
without doing this, an error message will remain on your
screen until you reinsert the card, and you may lose your
images.

1. Make sure the printer is turned on.

❏ If you’re running Windows XP or 2000, click the Unplug
or Eject Hardware icon on the taskbar, then stop the
EPSON storage device.

2. Insert your memory card into the appropriate adapter, if
necessary.

Printing an Index

3. Insert the adapter into the printer’s card slot.
Make sure the arrow is up and
pointing into the slot

Unless you’re using the optional preview monitor, it’s a good
idea to start by printing an index. An index shows small,
numbered images of all the photos on your memory card and
helps you select the photos you want to print.
1. Make sure your memory card is inserted and plain paper is
loaded in the printer.
2. Press the Cancel button to clear any settings you may have
made. Index is automatically selected as the Print Mode
setting:
Index is automatically
selected

Files on the card must be in JPEG format, as written by a
digital camera.
Image resolution may range from
160 × 160 to 3200 × 3200 pixels.

3. Press the

Print button. Your index is printed.

The card may contain more than 999 images, but the
printer can read only the first 999.
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Printing Your Photos
You can select one or more photos for printing:
❏ If you select one photo, you can print one or more copies of
it on a page, depending on your selected layout. With the
copies option, you can print multiple pages of your selected
layout.

5. In the PhotoEnhance menu, select On (if your camera
supports PRINT Image Matching™ or to improve
brightness and contrast) or Off.
6. Press the

Print button. Your print job begins printing.

When using the printer in stand-alone mode, you can make
additional changes to your images before printing. For
example, you can adjust the brightness or use various
filters to make color corrections. These changes do not
affect your original photo files, just the way they’re printed.
For details, see the Printer Basics book.

❏ If you select a set of photos, you can print them as a group
using a variety of layouts. If you’ve selected more photos
than can fit on a page, the printer automatically prints
additional pages as needed, using the selected layout.

To cancel a print job while printing, press the Cancel
button.

Make sure the type of paper you want to use is loaded in the
printer, then follow these steps:
1. Select your Print Mode (All, One, or Set), depending on
which photos you want to print.

Testing the Printer

2. Select the appropriate Paper Type and Paper Size settings.
See page 3 to choose the correct Paper Type setting.

You can run a printer self-test to determine whether a problem
comes from the printer itself or some other source.

3. In the Page Layout menu, select one of the options shown
below.

1. Make sure both the printer and computer are turned off.
Then disconnect the USB cable from the printer.

Prints one photo per sheet, borderless; fits the photo
lengthwise on the paper.
Prints 1, 2, 3, or 4 photos per sheet, with borders
around the edges.

2. Make sure letter-size or larger paper is loaded in the printer.
3. Hold down the b maintenance button, then press and
release the P power button.
The printer prints a test page showing its ROM version
number, black and color ink percentages remaining, and a
nozzle check pattern. (If the pattern has gaps, you need to
clean the print head; see page 8.)

Prints 20 photos per sheet. If you select a set of photos,
the photo number and date are also printed with each
photo. (Good for printing larger-size index prints.)

❏ If the test page prints, the problem probably lies in your
memory card, software settings, interface cable, or
computer. Your software may not be installed correctly.

Your photos are automatically sized to fit the type of
paper you’ve loaded.

❏ If the test page doesn’t print, you may have a problem
with the printer. Try the suggestions in the Printer
Basics book. If you can’t solve the problem yourself,
contact your dealer or EPSON.

If you’re printing on roll paper, the page layout is
automatically selected (you can print only borderless
photos on roll paper).

4. At the Select Photo menu, press the
picture you want to print.

button to select the

4. After examining the test page, remember to turn off the
printer and reconnect its cable to your computer.

If you’re printing various photos, press the round Select
Photo button when the number of the picture you want to
print is displayed. Continue pressing this button to print
additional copies of this photo (shown in the Copies menu).
When done, use the and buttons to select additional
photos.
If you’re printing just one photo (Print Mode is set to One),
you can use the Copies menu to select the number of pages
you want to print. (If the Print Mode is on Set, the number
of pages is automatically determined; you cannot change
this setting.)
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Replacing an Ink Cartridge
When the red b error light flashes, an ink cartridge is low on
ink. This is a good time to make sure you have a new cartridge
handy. When the red b error light stays on, you may need to
replace one of the cartridges.
The red b error light also comes on if your paper runs out
or is jammed, so make sure to check your paper before
replacing a cartridge.

Removing and Installing Ink Cartridges
Be sure you have a new ink cartridge before you begin. Once
you start the ink cartridge replacement procedure, you must
complete all the steps in one session.
1. Make sure the printer is turned on and not printing, then
open the printer cover.
2. Press the e ink cartridge replacement button. The print
head moves to the center and the Processing light flashes.

Check the control panel to see which cartridge is low or
empty:
Ink status

Control panel display

Ink low—black

Ink low—color

Ink empty—black

3. The color cartridge is on the right and the black is on the
left. Open the ink cartridge cover. The cartridge rises up
from its holder.
Ink empty—color

You cannot print if either ink cartridge is empty. Leave
the empty cartridge installed in the printer until you have
obtained a replacement, or the ink remaining in the print
head nozzles may dry out.

When an installed cartridge is more than six months old, you
may need to replace it if printouts don’t look their best. If the
quality doesn’t improve after cleaning and aligning the print
head, you can replace the cartridge even if the b error light is
off.
Use these EPSON ink cartridges within six months of
installing them and before the expiration date on the package:

4. Lift the cartridge out of the printer and dispose of it
carefully.

❏ Black ink cartridge: T007201
❏ Color ink cartridge: T008201
To ensure good results, use genuine EPSON ink
cartridges and do not refill them. Other products may
cause damage to your printer not covered by EPSON’s
warranty.

When you need new ink cartridges, contact your dealer or
call the EPSON Store at (800) 873-7766 or visit
www.epsonstore.com (U.S. sales only). In Canada, please call
(800) 463-7766 for dealer referral.
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5. Unwrap the new ink
cartridge. Then remove
only the yellow tape
seal on top.

black
cartridge

color
cartridge

9. Press the e ink cartridge replacement button and close the
printer cover. The printer begins charging the ink delivery
system.

You must remove the yellow tape from the top of the
cartridge or you will permanently damage it.
Don’t try to remove the clear seal underneath
the cartridge.

The Processing light flashes, and the printer makes noise.
Charging takes about one minute. When it’s finished, the
Processing light stops flashing and stays on, and the red
b error light goes out.

Don’t touch the green circuit board on the back of
the cartridge; you may inhibit normal operation and
printing.

6. Lower the cartridge into the holder, resting it on top of the
hooks as shown.

Never turn off the printer while the Processing light
is flashing, unless the printer hasn’t moved or made
noise for more than 5 minutes.

Don’t place the cartridge under the hooks, or they
may break when you close the cover.

Cleaning the Print Head
Set cartridge on
top of hooks

If your printouts are unexpectedly light or faint, colors are
missing, or dots or lines are missing, out of place, or broken,
you may need to clean the print head. This unclogs the nozzles
so they can deliver ink properly. Print head cleaning uses ink,
so clean it only if quality declines.
When you don’t turn on your printer for a long time, the
print quality can decline. It’s a good idea to turn on your
printer at least once a month to maintain good print
quality.

7. Close the ink cartridge cover (press down firmly until it
snaps shut).

Follow these steps to run the head cleaning utility:
1. Make sure the printer is turned on but not printing, and the
red b error light is off. (If the red light is flashing or on,
you may need to replace the ink cartridge; see page 7 for
details.)
2. Windows: Right-click the
printer icon on your taskbar
(in the lower right corner of your screen). Select Head
Cleaning.
Macintosh OS 8.6 to 9.x: Choose File > Page Setup or
Print. Click the
Utility button, then click the
Head
Cleaning button.
Macintosh OS X: Open the Applications folder and select
EPSON Printer Utility. Select SP 825 in the printer list,
click OK, and select Head Cleaning.

8. If you need to replace the other ink cartridge, repeat steps 3
through 7 before continuing with step 9.

3. Follow the instructions on the screen to clean the print
head.
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Cleaning takes about 30 seconds, during which the printer
makes some noise and the green Processing light flashes.
4. When the green Processing light stops flashing, make sure
paper is loaded in the printer and click Print nozzle check
pattern. Then click Print. The nozzle check pattern is
printed.

4. Examine each row and select the line (1–15) in which the
dots are best-aligned vertically (printed on top of each
other). You may need to use a magnifying glass or eye loupe.

5. Examine the printed pattern. Each staggered horizontal and
straight vertical line should be complete, with no gaps in the
dot pattern, as shown below:

❏ If the nozzle check pattern has no gaps or lines, click Finish.
Then enter the number of the best line for each row in the
corresponding box on the screen:

❏ If any dots are missing (as shown below), click Clean to
clean the print head again.

If you don’t see any improvement after cleaning three or four
times, try turning off the printer and waiting overnight—this
allows any dried ink to soften—and then try cleaning the print
head again.

Aligning the Print Head
If your printouts contain misaligned vertical lines, or you see
light or dark horizontal banding, you may need to align the
print head. Make sure you’ve cleaned the print head first, as
described in the previous section, to ensure that the problem
isn’t caused by clogged nozzles.
If your image looks texturized or blurry, make sure the
platen gap lever is not in the ^ position for envelopes.

1. Turn on the printer and load a sheet of letter-size plain
paper.
2. Windows: Right-click the printer icon on your taskbar
(in the lower right corner of your screen) and select Print
Head Alignment.
Macintosh OS 8.6 to 9.x: Choose File > Page Setup or
Print. Click the
Utility button, then click the
Print
Head Alignment button.
Macintosh OS X: Open the Applications folder and select
EPSON Printer Utility. Select SP 825 in the printer list,
click OK, and select Print Head Alignment.
3. Follow the instructions on the screen to print an alignment
pattern.

5. Click Finish.
6. If you chose a line other than number 8, click Realignment
to print another test page, then repeat step 4.

Transporting the Printer
If you move your printer some distance, you need to prepare it
for transportation in its original box or one of a similar size.
To avoid damage, always leave the ink cartridges
installed when transporting the printer.

Follow these steps:
1. Turn on the printer, wait until the print head locks in the
far right position, then turn off the printer.
2. Unplug the power cord from the electrical outlet. Then
disconnect the printer cable from the printer.
3. Take out any paper and remove the paper support.
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4. Open the printer cover. Secure the ink cartridge holder to
the printer with tape as shown, then close the printer cover.
IMPORTANT:
Tape the ink
cartridge holder to
the printer case

5. Push in the output tray extension and close the tray.
6. Repack the printer and its attachments in the original box
(if possible) using the protective materials that came with
them. See your Start Here sheet.
Keep the printer level as you transport it.
After moving the printer, remove the tape securing the print
head before turning on the printer. If print quality is poor,
clean the print head (see page 8); if output is misaligned, align
the print head as described in the previous section.

Related Documentation
CPD-14526

EPSON Stylus Photo 825 Printer Basics

CPD-14525

EPSON Stylus Photo 825 Start Here

CPD-14524

EPSON Stylus Photo 825 Quick Reference
guide

CPD-14527

EPSON Stylus Photo 825 CD-ROM with
electronic Reference Guide

PL-SP825

Parts Price List
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